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Chapter 1 Working with Visual SourceSafe

This explains source file version management using Visual SourceSafe.

 Source File Management

This explains source file version management using Microsoft® Visual SourceSafe™

Version 5.0 (called VSS below).

Following the procedures will allow you to execute VSS functions from the SOFTUNE

WORKBENCH.

Refer to the VSS Manual  for details concerning the other settings and how to handle

VSS.



  

1.1 Setting VSS

This section explains the setting items of VSS.

 Procedures for Setting VSS

This explains the necessary settings for VSS for when you are executing VSS

commands from SOFTUNE WORKBENCH.

 VSS Administrator Settings

1. Register the user.

2. By placing a check mark in the check box for [Use network name for

automatic log in] in the option dialog box, you won't need to specify a user

name or password when executing commands such as Checkout.  Refer to

the VSS Manual  for details on other settings.

Figure 1.1-a  Example Setting of VSS Administrator

 VSS Explorer Settings

1. Generate a project.  Generate a project using the same name as a project

when generating with SOFTUNE WORKBENCH.

2. Set the work directory.  Set the directory for the project you generated.

3. Place a checkbox in the "Assume working folder based on current project"



dialog box so that you can copy the file into the directory you set in step 2.

4. Add the file to the VSS project.  Register the source file and include file.

Also, register the project file **.prj and the option data file **.dat.

Figure 1.1-b  Example Setting of VSS Explorer



  

1.2 Setting the Softune Workbench

This section explains the setting items of the SOFTUNE WORKBENCH.

 Softune Workbench Settings

This section explains the procedures for registering the VSS commands in the

SOFTUNE WORKBENCH tool startup menu and it provides an example of the command

registration.

Figure 1.2-a  Example Setting of the Tool Setting Dialog Box

Select [Tool Option] from the [Setup] menu in SOFTUNE WORKBENCH to open the Tool

Option Dialog box.  Input the necessary items into this dialog box.

Placing a check mark in the "Designate additional option menu when executing"

makes it possible for you to add commands when executing.

Placing a check mark in the "Use output window" will cause the results of the

command to be output to the output window.  Specify using the -I-N option not to

request user input.  When user input is requested, you cannot end the command

from Softune Workbench.  Therefore, you must select the startup tool from the Task

Bar and input Ctr-C + CtrZ  to abort the command.

In this example, VSS is installed in C:\VSS.



[Example of the Tool Options]

 Startup Visual SourceSafe

Title : Startup Visual SourceSafe

Execution File Name : C:\VSS\WIN32\Ssexp.EXE

Option :

Directory When Executing : C:\VSS\WIN32\

Specified Additional Option when Executing No Check

Use Output Window No Check

 Check out all files

Title : Check out all files

Execution File Name : C:\VSS\WIN32\SS.EXE

Option : Checkout -I-N

Directory When Executing : %x

Specified Additional Option when Executing Checked

Use Output Window Checked

 Check in all files

Title : Check in all files

Execution File Name : C:\VSS\WIN32\SS.EXE

Option : Checkin -I-N

Directory When Executing : %x

Specified Additional Option when Executing Checked

Use Output Window Checked

 Undo check out

Title : Undo check out

Execution File Name : C:\VSS\WIN32\SS.EXE

Option : UndoCheckout -P$/%X -I-N

Directory When Executing : %x

Specified Additional Option when Executing Checked

Use Output Window Checked

 Get new file

Title : Get new file

Execution File Name : C:\VSS\WIN32\SS.EXE

Option : Get $/%X -I-N

Directory When Executing : %x

Specified Additional Option when Executing No Check

Use Output Window Checked

 Current project



Title : Current project

Execution File Name : C:\VSS\WIN32\SS.EXE

Option : cp $/%X

Directory When Executing : %x

Specified Additional Option when Executing No Check

Use Output Window Checked

 Add source file

Title : Add source file

Execution File Name : C:\VSS\WIN32\SS.EXE

Option : Add -I-N

Directory When Executing : %x

Specified Additional Option when Executing Checked

Use Output Window Checked

 Project information

Title : Project information

Execution File Name : C:\VSS\WIN32\SS.EXE

Option : Dir -E

Specified Additional Option when Executing No Check

Use Output Window Checked



  

1.3 Example Operation

This section provides an example operation to execute the source version
management function in SOFTUNE WORKBENCH and VSS.

 Operating Procedures

1.3.1 Generating a New Project in SOFTUNE WORKBENCH

1.3.2 Registering a Project withVSS

1.3.3 Revising a File and Updating a Project

This section uses creation of a project comprising the following as an example.

Project Name: VssSample

Project Directory: c:\VssSample

Registration Filename: c:\VssSample\startup.asm, c:\VssSample\main.c

User Included Filename: c:\VssSample\define.h



  

1.3.1 Generating a New Project in SOFTUNE WORKBENCH

This uses SOFTUNE WORKBENCH to generate project for source version
management.

 Generating a New Project in Softune Workbench

1. Generate a new project using Softune Workbench.

2. Add a file (member) to the project.

The file should be generated below all project directories.  If you are

registering a pre-existing file to the member, copy to below the project

directory once.  This is the same for user include files.

3. Set the options.

4. Analyze those dependent on include files.

5. Close the project and save the revised data.

Figure 1.3-a  List of Files of the Project

File List After Generating a Project
C:\VssSample\Vsssample.prj (Project File) Files automatically

VssSample.dat (Option Data File) generated by
Startup.asm (Source File) SOFTUNE WORKBENCH

Main.c (Source File)
Define.h (User Include File)



Figure 1.3-b  Example Project Generation in SOFTUNE WORKBENCH



  

1.3.2 Registering a Project with VSS

This registers to VSS a project generated in SOFTUNE WORKBENCH.

 Registering a Project to VSS

1. Generate a project using the VSS explorer.

Set the project name to the same project name as the one that was generated

in SOFTUNE WORKBENCH (Example: VssSample).

2 Add a file to the VSS project.

3. Set the work folder.  This is the directory which generated the project.

In this example: Set to c:\VssSample

4. Close VSS.

Specifies the project
directory specified by
SOFTUNE WORKBENCH

Generate with same name as the
project name generated by
SOFTUNE WORKBENCH

The file registered to the project
Project file

Registers option data files

 Figure 1.3-c  Example of VSS Project Generation



  

1.3.3 Revising a File and Updating a Project

This section explains how to revise files and update project information.

 Revising Files

You must check out all source files from VSS in order to revise source files.

The operating procedures are described below.

1. Select the filename to check out in the project window.  You can make

multiple selections.

2. Select [Setup], [Tool Startup] and [Check out all files] (Refer to 1.2 Setting

SOFTUNE WORKBENCH for an example setting).

3. Open the Add Parameter Setting dialog box.  Specify the " $/%X/%F%e"

macro in the Add Parameter.  Refer to the section 1.8 Setting External Tool

in the User's Manual for details.  When main.c is selected in the project

window, the command line will open as shown below and startup.

c:\VSS\win32\Ss.exe checkout -I-N $/VssSample/main.c

Specify in Add Parameter (Input a space at the heading).

Figure 1.3-d  Setting Dialog Box for Add Parameter (Check in all files)

4. When check out all files is completed normally, the filename that was

checked out is displayed in Output Window.

After revising the source file, you must check in all source files in VSS.

The operating procedures are described below.

1. Select the filename to check in the project window.  You can make multiple

selections.

2. Select [Setup], [Tool Startup] and [Check in all files].

3. Open the Add Parameter Setting dialog box.  Specify the " $/%X/%F%e"

macro in the Add Parameter.  Refer to the section 1.8 Setting External Tool

in the User's Manual for details.  When main.c is selected in the project



window, the command line will open as shown below and startup.

c:\VSS\win32\Ss.exe checkin -I-N $/VssSample/man.c -c"1st Version"

Macro Statement (Shows filename)
(Input a space at the header).

Comment Statement

Figure 1.4-e  Setting Dialog Box for Add Parameter (Check in all files)

4. When check in all files is completed normally, the filename that was checked

in is displayed in output window.

 Updating Project Information

When you want to change a tool option or project information of the member

organization, you must check out all project files and option data files from VSS.

The operating procedures are described below.

1. Select [Setup], [Tool Startup] and [Check out all files].

2. Open the Add Parameter Setting dialog box.  Specify the project filename

and the option data filename.

Project Filename and Option Data Filename

Figure 1.4-f  Setting Dialog Box for Add Parameter

3. When the check in all files is completed normally, the project filename and

option data filename are displayed in Output window.

4. Change the tool option or add a member.



5. The project information you changed overwrites the original information.

Select the filename with [Save...] from the [File] menu.

6. All project files and option data files are checked in.



  

1.4 Precautions for Use

This section explains the precautions when using SOFTUNE WORKBENCH together
VSS for development.

 Precautions for Use

Be careful of the following points when using SOFTUNE WORKBENCH together VSS for

development.

 When executing a VSS function from the command line, you must quit VSS

once in order to validate the setting data in the work folder.

 There are cases where the built-in editor's status bar is [READ] when you

execute check out all files when a file is opened by the built-in editor.  If this

should occur, move the focus to a different window.

 It is necessary that you check that the VSS current project is current before

executing the command when adding a source file to the VSS.  Add the

source file after moving the current project for other projects.



  

Chapter 2 Working with PVCS Version Manager

This section explains source file version management using the PVCS Version
Manager.

 Source File Management

This explains source file version management using INTERSOLV® PVCS® Version

Manager™ Version 6.0 (called PVCS_VM below).

Following the procedures described below will allow you to execute PVCS_VM

functions from the SOFTUNE WORKBENCH.

Refer to the PVCS_VM Manual for details concerning the other settings and how to

handle PVCS_VM.



  

2.1 Setting PVCS_VM

This section explains the settings of PVCS_VM.

 Procedures for Setting PVCS_VM

This explains the necessary settings for PVCS_VM for when you are executing

PVCS_VM commands from SOFTUNE WORKBENCH.

1. Startup PVCS_VM and open the Master Project.  Execute [Configure] from

the [Project] menu and select [Project Options].  Turn the Check Box ON for

[Make Select Source] in the configuration file of the [Configure Project] dialog

box.

Figure 2.1-a  Master Project [Configure Project] Dialog Box

When executing a PVCS_VM function from the command line, the

Master.cfg data is loaded.  This is only the data whose configuration file

for each PVCS_VM project differs with the Master.cfg  data.  Therefore, in

order to allow the command line execution operation to be the same as a GUI,



it is necessary to load the Master.cfg  data.  This is unnecessary if all of the

necessary data is listed in the configuration file of the each project.

2. Generate an archive directory and register the source file to develop.  Also,

the source file is managed by the PVCS_VM archive directory.  For

explanations below, it is assumed that the following settings have been made

for the archive directory.  The archive directory drive name is E.

 Archive Directory;  E:\Pvcs_DB\911

3. Set the PVCS_VM project.  The following example assumes the following

project, configuration file and work file directory.  Also, set the project bus

for the Softune Workbench as the work file directory.  C is the name of the

drive for the project to set with the Softune Workbench and E is the name of

the drive where PVCS_VM is installed.

 Project: E:\Pvcs\pvcsproj\frsample.prj

 Configuration File: E:\Pvcs\pvcsproj\frsample.prj\frsample.cfg

 Work File Directory: C:\FETOOL\PVCS_FRV02



 Figure 2.1-b  Example Setting of PVCS_VM Project

4. With the project generated in 3, open the [Project] menu, execute the

[Configure Project] command and select the [Network].  If there is no

[HOST] in the log install list, select the [HOST] from the log in source to add

it.  Also, when using an access control data base, the user ID and the name

of the user who logged into the operating system must match.



 Figure 2.1-c  frsample Project [Configure Project] Dialog Box



  

2.2 SOFTUNE WORKBENCH Settings

This section explains setting items for the SOFTUNE WORKBENCH.

 Softune Workbench Tool Setting Procedures

This explains the procedures for registering a PVCS_VM command in the SOFTUNE

WORKBENCH Tool startup menu and it explains an example command registration.

Select [Setup] and [Tool Option] in the SOFTUNE WORKBENCH menu to open the tool

setting dialog box.  Input the following items into this dialog box.

The command execution results are output to the screen if you place a check mark into

[Use output window].  However, if user input is requested when executing the

command, you cannot quit the user request input or the command from the SOFTUNE

WORKBENCH.  Therefore, you have to abort the command.  Select the startup tool

from the task bar and input Ctr-C + CtrZ to abort the command.  Check the details

of the command of PVCS_VM carefully when using.

The following example assumes that PVCS_VM is installed in the \Pvcs directory on

the E drive and that source files are being managed by the archive directory

(E:\Pvcs_DB\911).

Also, this assumes that the Archive Suffix in the archive attributes set by PVCS_VM

are "??v."

Many of the PVCS_VM functions can be executed from the command line.  Cases

other than the example below can be executed from the SOFTUNE WORKBENCH in the

same way if the command and option are set.  Refer to the PVCS_VM Manual  to set

the necessary functions in the SOFTUNE WORKBENCH tools.

In the following example, refer to the section 1.8 Setting External Tool in the User's

Manual for details on macro specifications "%F" and "%f".

[Tool Option Examples]

 Check out all files

Title : Check out all files (Revision Lock)

Execution Filename : E:\Pvcs\win95\get.exe

Option : -c%x\frsample.cfg -l e:\pvcs_db\911\%F.??v(%x)

Directory When Executing : %x



 Check in all files

Title : Check in all files

Execution Filename : E:\Pvcs\win95\put.exe

Option : -c%x\frsample.cfg -u e:\pvcs_db\911(%f)

Directory When Executing : %x

 Check out all files

Title : Check out all files

Execution Filename : E:\Pvcs\win95\get.exe

Option : -c%x\frsample.cfg e:\pvcs_db\911\*.*(%x)

Directory When Executing : %x

 Revision Lock

Title : Revision Lock

Execution Filename : E:\Pvcs\win95\vcs.exe

Option : -c%x\frsample.cfg -l e:\pvcs_db\911(%f)

Directory When Executing : %x

 Undo check out, Lock Disable

Title : Undo check out, Lock Disable

Execution Filename : E:\Pvcs\win95\undocheck.bat

Option : %x %f %F

Directory When Executing : %x

Use Output Window No Check (For User Input Request)

<Note>

Generating a batch file for the undo check out, Lock Disable

The data for the undocheck.bat is shown below.  Generate in the specified directory.  This is a check

out command for revision lock after disabling the source file revision lock.

@echo on

e:

cd e:\Pvcs\win95

vcs -c%1\frsample.cfg -u e:\pvcs_db\911(%2)

get -c%1\frsample.cfg e:\pvcs_db\911\%3.??v(%1)

exit



 Generating a Softune Workbench Project

1. Generate a new project using SOFTUNE WORKBENCH.  The project directory

name must match the work folder name (In this example, set to

c:\FETOOL\PVCS_FRV02).

2. Copy the configuration file (in this example, frsample.cfg) generated by

PVCS_VM into the project directory generated by SOFTUNE WORKBENCH.

<Note>

This will mean that there are now 2 files named frsample.cfg that exist.  When executing the

PVCS_VM function from both the GUI and the command line, be careful that no disparity occurs

between these 2 configuration files.  Also, if you specify the full bus of the configuration file in the tool

setting example of the option specification, the above setting is unnecessary (Change %x to

E:\Pvcs\pvcsproj\frsample.prj).

3. After generating a new project, you must check out the source file managed

by the archive directory in the project folder before member registration.

Execute [Check out all files] that was registered as a tool.  Register the file

copied into the project folder in the member.



  

2.3 Example Operation

This section provides an example operation to execute the source version
management function using SOFTUNE WORKBENCH and PVCS_VM.

 Operating Procedures

This provides you with an example of operation for executing a PVCS_VM command

from the Softune Workbench.  These are the basic procedures.  Please refer to them.

Commands listed and explained below are those set by 2.2 SOFTUNE WORKBENCH

Settings.

If user input or decisions are necessary for file overwriting or comments depending on

the command, the command will be stopped part way so that you can input the

necessary items.

1. Startup the SOFTUNE WORKBENCH and open the project.

2. Specify the necessary file from the project window and execute [Setup], [Tool

Startup] and [Check out all files (Revision Lock)].

First, [Check out all files (Revision Lock)] the necessary file.  If this

command is not executed, you cannot make any revisions even if the file is

opened by the editor.

3. Revise the file.

4. After revising the file, execute [Setup], [Tool Startup] and [Check in all files].

Also, as necessary, execute the above command when added new files to the

SOFTUNE WORKBENCH.  This file check in operation will show the revised

data in the archive directory source file.

5. After executing check out all files (Revision Lock), execute [Setup], [Tool

Startup] and [Undo check out] if check in all files is necessary.  When

executing this command, you will be prompted whether to check out after the

revision lock is disabled.  Input [Y].  When this command is executed, all of

the revisions will be destroyed.  If you input [N], the file of the work file

directory will be capable of overwriting so be careful.

If you want to change tool options or project information such as member

configurations, you must check out the project file and option data file.



  

2.4 Precautions for Use

This section explains the precautions when using SOFTUNE WORKBENCH together
PVCS_VM for development.

 Precautions for Use

Be careful of the following points when using SOFTUNE WORKBENCH together

PVCS_VM for development.

 By executing 2.1 PVCS_VM Settings, the Master.cfg data is loaded

when executing a PVCS_VM function from the command line.  The

configuration file for each project differ from the Master.cfg data.

Therefore, in order to allow the command line execution operation to

be the same as a GUI, it is necessary to load the Master.cfg data.

This is unnecessary if all of the necessary data is listed in the

configuration file of the each project.

 By executing 2.2 SOFTUNE WORKBENCH Settings, there will be 2

frsample.cfg files existing.  If executing a PVCS_VM function with

both GUI and from the command line, be careful that no disparity

occurs between these 2 configuration files.  Also, if you specify the full

bus of the configuration file in the tool setting example of the option

specification, the above setting is unnecessary.

 There are cases where the built-in editor's status bar is [READ] when

you execute check out (Revision Lock) when a file is opened by the

built-in editor.  If this should occur, move the focus to a different

window.


